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内容

• ロボットコンテスト AWS Robot Delivery Challenge 

• ロボコンの中での AWS と AWS RoboMaker 活用事例

• これからのロボコン

• AWS RoboMaker 活用のヒント
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AWS Robot Delivery Challenge

AWS 日本初開催、学生対象、ロボットで指定された場所に荷物を配達、タイムを競
うロボットコンテスト

2月より参加者募集、シミュレーション予選開始

5月11日(月) シミュレーション予選結果発表

9月15日(水) AWS Summit Online にて本戦（オンライン開催）
• 本戦は実際のロボットを制御し自律走行のアルゴリズムの性能を競うタイムトライアル

• ロボットは事務局が用意、全チーム同じロボットでタイムを競う
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シミュレーション予選
AWS RoboMaker のクラウドシミュレータを利用

シミュレーションワールドと自律走行ができるサンプルアプリケーションを提供

• １つのチェックポイントを目指す

• 提供されたツールで各自タイム計測
をして報告

• 上位チームには工夫した点などをイ
ンタビュー
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• 約3分の準備時間ののちスタート

本戦

シミュレーション予選と同じコース

全チーム遠隔から参加

• 本戦予選では全チーム異なる障害物が配
置される。決勝戦は全チームシミュレー
ション予選と同じ障害物の配置

• 指定された場所に荷物を届ける。積み下
ろしは現地スタッフが行う。

• Web 会議システム Amazon Chime を
通して会場の様子を確認、Webインター
フェースを通じてロボットに自律走行の
指令を送る
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その中身。ROS そして AWS RoboMaker

ROS
ロボティクスの研究や学習において最もよく使われているソフトウェアフレームワーク。
2020 年(2019/7 – 2020/7) には 3,800 万の .deb (Linux Debian) パッケージがダ
ウンロードされている

AWS RoboMaker
ロボットアプリケーションの「開発」、「シミュレーション」、「OTAアプリケーショ
ンインストール」ができる AWS のサービス。

ロボットアプリケーション開発の各フェーズをクラウドで支援

各チームはROSアプリケーションを開発。開発ツールとテストの環境に AWS RoboMaker を利用。
ロボット工学専門家でなくとも参加できるようサンプルアプリケーションとチューニングのポイン
トを案内
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AWS RoboMaker 基礎
ロボットアプリケーションとシミュレーションアプリケーション

AWS RoboMaker では作成したプログラムを「シミュレーションアプリ
ケーション」 と「ロボットアプリケーション」の２種類で登録できる

シミュレーションアプリケーション
シミュレーションワールドの読み込み、仮想ロボットモデルの起動などを行う

ロボットアプリケーション
ロボットの操作プログラムを実装する
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参加チームに提供したサンプルアプリケーション

シミュレーションアプリケーション
コンテストで使うコースのシミュレーションワールド

コンテストで使うロボットのシミュレーション環境用仮想モデル

ロボットアプリケーション
ロボットをリモート操作する機能 (AWS IoT 利用)

タイム計測ツール

SLAM (地図作成) サンプルプログラム

自律走行 (ナビゲーション) サンプルプログラム

https://github.com/aws-samples/aws-robomaker-sample-application-delivery-challenge

https://github.com/aws-samples/aws-robomaker-sample-application-delivery-challenge


© 2020, Amazon Web Services, Inc. or its affiliates. All rights reserved.

In Partnership with

シミュレーション予選
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本戦用アプリケーションの提出

AWS Lambda

:

…

…
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本戦

AWS RoboMaker

AWS loT Greengrass

Amazon Chime
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本戦タイムライン(本戦予選）
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本戦タイムライン(本戦決勝）
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共通のシミュレーション環境を簡単に提供できる

開発用専用PCを用意する必要なし。ロボット工学初心者にもロボット工学
最新の技術への体験を提供できる

シミュレーションで試したプログラムをそのまま共通ロボットにデプロイ
できる

クラウド経由のデプロイの利点。アプリケーション提出の手間を最小限に

AWS RoboMaker 採用のメリット

共通のシミュレーション環境を簡単に提供できる

開発用専用PCを用意する必要なし。ロボット工学初心者にもロボット工学
最新の技術への体験を提供できる

シミュレーションで試したプログラムをそのまま共通ロボットにデプロイ
できる

クラウド経由のデプロイの利点。アプリケーション提出の手間を最小限に
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これからのロボコン

• ハードウェア中心のロボコンとソフトウェア中心のロボコン

• ロボットを操作するプログラムが高度化

• ハードウェア開発、ソフトウェア開発の分業化

• 共通ハードウェアでソフトウェアの完成度を競うコンテスト

• シミュレーションの有効利用

• リアルとシミュレーションのギャップ

• ハードウェア中心のロボコンとソフトウェア中心のロボコン
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• シミュレーションの有効利用

• リアルとシミュレーションのギャップ

• ハードウェア中心のロボコンとソフトウェア中心のロボコン
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• ハードウェア開発、ソフトウェア開発の分業化

• 共通ハードウェアでソフトウェアの完成度を競うコンテスト

• シミュレーションの有効利用

• リアルとシミュレーションのギャップ

• ハードウェア中心のロボコンとソフトウェア中心のロボコン
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• シミュレーションの有効利用

• リアルとシミュレーションのギャップ
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• シミュレーションの有効利用

• リアルとシミュレーションのギャップ
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• ロボットを操作するプログラムが高度化

• ハードウェア開発、ソフトウェア開発の分業化
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• リアルとシミュレーションのギャップ
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シミュレーションにおける計測の自動化

AWS Lambda

Amazon DynamoDB
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既存ロボット開発ワークフローの中でのAWS RoboMaker の活用

特定テストシナリオの実行をクラウドで行う
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ロボットアプリケーションのCI/CDにAWS RoboMakerを活用

AWS CodeBuild
Build and Bundle
Code in ROS Container

Bundles stored in S3

AWS Lambda
Batch Simulation Launcher

AWS RoboMaker
Simulation Service

Branch: 

integration 

Git Repository (GitHub or AWS Code Commit or Amazon S3)

Clone on 
Git Hook (Merge)

Branch:

master (release)

Branch: 

feature

AWS CodePipeline

AWS Step Functions: Simulate

AWS Lambda
Status Checker

AWS CodeBuild
Build and Bundle
Code in ROS Container

Bundles stored in S3

AWS Lambda
AWS RoboMaker
Deploy Launcher

Clone on 
Git Hook (Merge)

AWS CodePipeline

AWS RoboMaker
Fleet Management

Test Fleet

AWS Step Functions: Physical 

Testing and Deployment

Prod Fleet

ROS/ROS2 
Development
Environment

ROS/ROS2
Simulation 

Environment

Te
st

s 
 P

a
ss

ed

Pull Request

Blessed Code 

Bundle

https://aws.amazon.com/jp/blogs/news/aws-robomaker-ros-app-ci-pipeline/

https://aws.amazon.com/jp/blogs/news/aws-robomaker-ros-app-ci-pipeline/
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AWS RoboMaker で始めるロボットアプリケーション開発

シミュレーションワールド

仮想ロボットのモデル

ロボット制御プログラム
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シミュレーションワールド

https://aws.amazon.com/jp/robomaker/resources/#Simulation_World_Assets

https://aws.amazon.com/jp/robomaker/resources/#Simulation_World_Assets


© 2020, Amazon Web Services, Inc. or its affiliates. All rights reserved.

In Partnership with

ロボットのシミュレーションモデル

http://wiki.ros.org/urdf/Tutorials/Create your own urdf file
http://wiki.ros.org/urdf
https://industrial-training-master.readthedocs.io/en/melodic/_source/session3/Intro-to-URDF.html
http://wiki.ros.org/urdf/Examples

ロボット操作プログラム

http://wiki.ros.org/ja/navigation

http://wiki.ros.org/gmapping

https://moveit.ros.org/

http://wiki.ros.org/urdf/Tutorials/Create%20your%20own%20urdf%20file
http://wiki.ros.org/urdf
https://industrial-training-master.readthedocs.io/en/melodic/_source/session3/Intro-to-URDF.html
http://wiki.ros.org/urdf/Examples
http://wiki.ros.org/ja/navigation
http://wiki.ros.org/gmapping
https://moveit.ros.org/
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AWS RoboMaker を試す

https://pages.awscloud.com/rs/112-TZM-766/images/RDC-
01_AWS_Summit_Online_2020.pdf

https://aws.amazon.com/jp/builders-flash/202002/robotics-01/

https://robomakerworkshops.com/

https://pages.awscloud.com/rs/112-TZM-766/images/RDC-01_AWS_Summit_Online_2020.pdf
https://aws.amazon.com/jp/builders-flash/202002/robotics-01/
https://robomakerworkshops.com/


Thank you!
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河田 卓志（かわた たくじ）

katakuji@amazon.co.jp
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Screenshot

Place a screenshot behind 
the image of a laptop or 
smartphone to show it on 
a device.

1. Place the screenshot on the 
slide.

2. Use the Alignment tools or 
Selection Pane to place the 
screenshot behind the device. 
For more information on how 
to use the alignment tools 
and Selection Pane, refer to 
slides 58 and 59.

3. Resize and/or crop the 
screenshot to fit the device.
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Using videos

To keep the file size small enough to upload to 
the SRC, please wait until you get onsite to embed 
videos in the speaker-ready room.

To embed a video, you can use the Embed_Video
slide layout. You can also add a video to a slide by doing the 
following:

1. On the Insert tab, select Video. 

2. Choose either an online video or a video you have saved 
to your machine.

3. On the Video Tools menu, go to the Playback options to 
make the video play full screen, automatically or on-click, 
loop, hide when not playing, or rewind after playing.
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How to apply 
the template

Apply the template to an existing PowerPoint 
presentation

1. Save this template to your Desktop. 

2. Open an existing PowerPoint file that
you want to update. 

3. Select Design, scroll down, and select
Browse for Themes.

4. Browse to the template file (.potx) you saved
to your Desktop, and select Open.

5. Under Layout, right-click on the slide thumbnail, and 
select the layout you want to use (Title_#Speaker and 
Title_and_Content will
be the most common). 

6. Some things will shift when you do this. Adjust 
accordingly to get the slide how you want it. 
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Theme colors

R: 255
G: 255
B: 255

R: 242
G: 244
B: 244

The PowerPoint palette for this template has been 
built for you and is shown below.

Limit color usage to two colors per slide.
Choose one main color and one accent color from 
the first four colors of the template
(limit use of yellow and green).
Do not use different shades of a color.



© 2020, Amazon Web Services, Inc. or its affiliates. All rights reserved.

In Partnership with

Text

Accessibility

Do not use dark colored text on 
dark backgrounds
or light colored text
on light backgrounds.

Large text (above 24pt) and 
icons must have a contrast ratio 
of 3 or above.

Text Text

TextText Text
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Typography

Amazon Ember Light should be used for titles

Titles should be sentence case.

Hyperlink example Hyperlink example

https://aws.amazon.com/
https://aws.amazon.com/
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Typography continued

Select the appropriate font weight from the list of fonts.

These are all the usable fonts in the Amazon Ember family:

Amazon Ember

Amazon Ember Heavy

Amazon Ember Light

Amazon Ember Medium

Amazon Ember Thin  

Amazon Ember Italic

https://www.portal.reinvent.awsevents.com/fileDownload/C2D497D1A335355849377F9B672F6EDC/amazon_typography_all.zip
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Grid/guidelines

To view the grid, in the View tab, 
select Guides.

Or press Alt+F9. To turn it off, 
press Alt+F9 again.
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Quick Access Toolbar

PowerPoint has a toolbar populated with icons that perform 
common tasks. This can be a great way to save time, 
removing the need to repeatedly navigate through menus.

You can customize your Quick Access Toolbar to add buttons 
for alignment, formatting, and other adjustments you’ll be 
making frequently. To do this, on the far right of the Quick 
Access Toolbar, select the down arrow, and select More 
Commands.

Here, you can browse dozens of different commands, add 
and remove commands, and even export a Quick Access 
Toolbar to open it on another machine.
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Easy to use alignment tools

These are your
alignment tools in your 
Quick Access Toolbar. To 
learn how to add these, see 
the previous slide.
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Selection and formatting panes

To view an itemized list of objects on the slide and 
their order of appearance, under the File tab, in the 
Editing section, click Select, and then click Selection 
Pane.

To view the formatting options pane for 
objects on the slide, right-click the object, 
and select Format Shape.



© 2020, Amazon Web Services, Inc. or its affiliates. All rights reserved.

In Partnership with

Animation options
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Animation pane

Animations
Animation Pane
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Photography

Getty Images
Shutterstock
Creative Commons

http://www.gettyimages.com/
http://www.shutterstock.com/
http://creativecommons.org/
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Table 1

Placeholder Placeholder

Placeholder Placeholder Placeholder

Placeholder Placeholder Placeholder

Placeholder Placeholder Placeholder
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Table 2

Placeholder Placeholder

Placeholder Placeholder Placeholder

Placeholder Placeholder Placeholder

Placeholder Placeholder Placeholder
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Table 3

Placeholder Placeholder Placeholder

Placeholder Placeholder Placeholder Placeholder

Placeholder Placeholder Placeholder Placeholder

Placeholder Placeholder Placeholder Placeholder
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Charts
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AWS product and resource icons

Download icons to use in your 
presentation here: 
https://aws.amazon.com/
architecture/icons/

https://aws.amazon.com/architecture/icons/

